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Abstract: This project is designed to control a robotic wheelchair by voice commands for remote 

operation. An ARM series microcontroller is used together with an Android Application for the desired 

operation. The Android Application is connected to the Bluetooth module (HC-05) present on the Robot via 

Bluetooth. The commands are sent to the robot using push buttons or voice commands present on the 

android application. At the receiving end two dc servo motors are interfaced to the microcontroller where 

they are used for the movement of the wheelchair. The RF transmitter of the Bluetooth can take either 

switch press or voice commands which are converted to encoded digital data for the advantage of adequate 

range (up to 100 meters) from the robot. The receiver decodes the data before feeding it to another 

microcontroller to drive DC motors via motor driver IC for necessary work. This technology has an 

advantage over long communication range as compared to RF technology. Further the project can be 

developed using IoT technology where a user can control the robot from any corner of the world. 

 

Keywords: Assistive technology, Voice-controlled wheelchair, Speech recognition, Mobility, 

Independence, User testing 

 

I. INTRODUCTION 

This project banks on two major concepts namely robotics and voice recognition technology. Robotics as a discipline 

has seen unparalleled development since the early 1960s. It finds application in industries, manufacturing, bio 

engineering, space exploration and recreational activities like drones. Whereas speech recognition technology has also 

seen rapid development in the recent time. Models which might require ‘training’ to better adapt to the voice of the user 

resulting in increased accuracy. While those which do not require training are called speaker independent system. The 

voice commands can be a fixed set of commands (as in this project) while more advanced ones come with natural 

speech recognition which can process complete sentences or phrases in multiple languages and accent of the speaker.  

Like any other robotic application this project also has three major dimensions –  

(a) Mechanical Construction  

(b) Electrical Circuitry  

(c) Computer Programme.  

The mechanical construction of the project involves the frame of the wheelchair and two DC motors which drive the 

wheelchair. The electronic circuitry comprises of the Bluetooth module which facilitates the communication, Arduino 

Uno which interfaces with the motor driver also a part of the circuitry. The third is the computer programme written in 

IDE (Arduino) which acts the driver code for the wheelchair. The driver code is installed on the arduino which process 

the command received, interacts accordingly with the motor driver which makes the wheelchair move. 

 

1.1 Problem Definition 

To Design and develop a prototype model of showing the concept of automatic wheelchair with ignition switch which 

will show the working of application of automation. Also to fabricate the model of the same which would able to show 

the characteristics of systems and working according to need. 

 

1.2 Motivation 

Today in biomedical sector, a wheelchair is an important device for physically handicapped and aged person. We are 

trying to construct a voice controlled wheelchair which will recognize and follows natural language voice instruction 

and will move respectively. 
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1.3 Objectives 

 In order to fulfil the needs of present automatic wheelchair with ignition switch, some improvement must be 

made base on the problems statement:  

 To design and develop automatic wheelchair with ignition switch. 

 To minimize human effort. 

 To save time 

 Easy to operate. 

 

II. LITERATURE REVIEW 

Previously a many projects have ventured into the realm of wheelchair which communicates with its operator using 

voice in one way or the other. These projects function around the basic tenet of voice recognition or speech to text, the 

difference arises in the implementation driving code, sensor or mechanical part used. Some also include additional 

features like obstacle detection, conformation on receiving command, automatic breaking and speed limiting system. 

The purpose is to make innovation in the field of wheelchair automation so that it caters to multi-dimensional 

requirements from critical applications space exploration and military use to humanitarian innovation to help those with 

disabilities to drive themselves. Some the projects might require ‘training’ to better adapt to the voice of the user 

resulting in increased accuracy. While those which do not require training are called speaker independent system. The 

voice commands can be a fixed set of commands (as in this project) while more advanced ones come with natural 

speech recognition which can process complete sentences or phrases in multiple languages and accent of the speaker.  

The following project might be considered for further reading:  

[1] A.N Khan, K. Priya, S. Kumar-“Implementation of Voice Controlled Robotic vehicle with Automatic Braking and 

Obstacle Avoidance”. In INROADS Vol. 7 (Special Issue), 2018  

[2] Prof. B. Jolad, M. Arora, R. Ganu, C. Bhatia -“Voice Controlled Robotic vehicle”. In IRJET Volume: 04 Issue: 06, 

June-2017  

[3] Dr. M. Narayana, A. Alishety, H. Chapala -“Voice Controlled Robot using Android Application”. In International 

Journal of Engineering Innovation and Research Volume: 04 Issue: 02 

 

III. METHODOLOGY 

3.1 Block Diagram 

 

 

 

 

 

 

 

 

 

 

Block diagram of Electrical Architecture of the Voice Controlled Wheelchair 

The above diagram shows the electrical arrangement of the components required in the making of Voice Controlled 

Wheelchair. 

 

3.2 Working 

The system has two parts, namely; hardware and software. The hardware architecture consists of an embedded system 

that is based on Arduino Uno board, a Bluetooth Module, Motor Driver and an Android phone. The Bluetooth Module 

provides the communication media between the user through the android phone and the system by means of voice 

command given to the android phone. The user speaks the desired command to the “BT Voice Control for Arduino 

voice (AMR Voice Application)” software application installed in the android phone that is connected through 
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Bluetooth with Bluetooth Module HC-05. The voice command is converted to an array of string and the string is passed 

to Arduino Uno connected to it. Once the Bluetooth Module receives the message, the command sent will be extracted 

and executed by the microcontroller attached to it and depending on the commands fed to the Motor Driver, the motors 

will function accordingly. The system will interpret the commands and control the wheelchair accordingly via android 

application. 

 

III. METHODOLOGY 

The different directions of motions possible are: forward, backward, left, right and stop. In achieving the task, the 

controller is loaded with program using the Arduino programming language and arduino development environment.  

First make sure Bluetooth module is paired with the android mobile. The default password for pairing is “1234” or 

“0000”.  

When the user says “GO”, AMR Voice application sends the data in form of string “*GO#” to Bluetooth module 

connected to the circuit. When microcontroller detects “GO”, the motor attached to the wheelchair moves FORWORD. 

When the user says “BACK” AMR Voice application sends the data in form of string “*BACK#” to Bluetooth module 

connected to the circuit. 

When microcontroller detects “BACK”, the motor attached to the wheelchair moves REVERSE.  

When the user says “LEFT” AMR Voice application sends the data in form of string in form of string “*LEFT#” to 

Bluetooth module connected to the circuit. When microcontroller detects “LEFT” the moves the motor attached to the 

wheelchair LEFT side.  

When the user says “RIGHT” AMR Voice application sends the data in form of string “*RIGHT#” to Bluetooth 

module connected to the circuit. When microcontroller detects “RIGHT” the moves the motor attached to the 

wheelchair RIGHT side.  

When the user says “STOP” button which is in the Centre of remote the AMR Voice application sends the data in form 

of string “*STOP#” to the Bluetooth module connected to the circuit. When microcontroller detects “STOP” the 

wheelchair gets stopped.  

Click on “DISCONNECT” icon to disconnect the paired Bluetooth module. 

 

Software Specifications 

ARDUINO SOFTWARE IS USED 

How to start with Arduino software: 

Get an Arduino board and USB cable 

In this tutorial, we assume you're using an Arduino or Genuino Uno or an Arduino or GenuingMega2560.If   you   are   

using   a   retired   board   as Arduino Duemilanove, Nano or Diecimila please refer to the driver installation 

instructions end of this document. If you have another board, read the corresponding page linked in the main getting 

started page. 

 

Connect the board 

The USB connection with the PC is necessary to program the board and not just to power it up. The Uno and Mega 

automatically draw power from either the USB or an external power supply. Connect the board to your computer using 

the USB cable. The green power LED (labelled PWR) should go on. 

Install the board drivers 

If you used the Installer, Windows - from XP up to 10 - will install drivers automatically as soon as you connect your 

board. 

If you downloaded and expanded the Zip package or, for some reason, the board wasn't properly recognized, please 

follow the procedure below. 

Click on the Start Menu, and open up the Control Panel. 

Click on the Start Menu, and open up the Control Panel. 

While in the Control Panel, navigate to System and Security. Next, click on System. Once the System window is up, 

open the Device Manager. 
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Look under Ports (COM & LPT). You should see an open port named "Arduino UNO (COMxx)". If there is no COM 

& LPT section, look under "Other Devices" for "Unknown Device". 

Right click on the "Arduino UNO (COmxx)" port and choose the "Update Driver Software" option. 

Next, choose the "Browse my computer for Driver software" option. 

Finally, navigate to and select the driver file named "arduino.inf", located in the "Drivers" folder of the Arduino 

Software download (not the "FTDI USB Drivers" sub-directory). If you are using an old version of the IDE (1.0.3 or 

older), choose the Uno driver file named "Arduino UNO.inf" 

Windows will finish up the driver installation from there. 

 

Launch the Arduino Software (IDE) 

Double-click the Arduino icon (arduino.exe) created by the installation process. (Note: if the Arduino Software loads in 

the wrong language, you can change it in the preferences dialog 

Open the blink example 

Open the LED blink example sketch: File > Examples >01.Basics > Blink. 

Click on the Start Menu, and open up the Control Panel. 

While in the Control Panel, navigate to System and Security. Next, click on System. Once the System window is up, 

open the Device Manager. 

Look under Ports (COM & LPT). You should see an open port named "Arduino UNO (COMxx)". If there is no COM 

& LPT section, look under "Other Devices" for "Unknown Device". 

Right click on the "Arduino UNO (COmxx)" port and choose the "Update Driver Software" option. 

Next, choose the "Browse my computer for Driver software" option. 

Finally, navigate to and select the driver file named "arduino.inf", located in the "Drivers" folder of the Arduino 

Software download (not the "FTDI USB Drivers" sub-directory). If you are using an old version of the IDE (1.0.3 or 

older), choose the Uno driver file named "Arduino UNO.inf" 

Windows will finish up the driver installation from there. 

 

Launch the Arduino Software (IDE) 

Double-click the Arduino icon (arduino.exe) created by the installation process. (Note: if the Arduino Software loads in 

the wrong language, you can change it in the preferences dialog. 

Open the blink example 

Open the LED blink example sketch: File > Examples >01.Basics > Blink. 

Select your board 

You'll need to select the entry in the Tools > Board menu that corresponds to your Arduino or Genuino board 

Select your serial port 

Select the serial device of the board from the Tools | Serial Port menu. This is likely to be COM3 or higher (COM1 

andCOM2 are usually reserved for hardware serial ports). To find out, you can disconnect your board and re-open the 

menu; the entry that disappears should be the Arduino or Genuino board. Reconnect the board and select that serial 

port. 

 

Upload the program 

Now, simply click the "Upload" button in the environment. Wait a few seconds - you should see the RX and TX leds on 

the board flashing. If the upload is successful, the message "Done uploading." will appear in the status bar. 

A few seconds after the upload finishes, you should see the pin 13 (L) LED on the board start to blink (in orange). If it 

does, congratulations! You've gotten Arduino or Genuino up-and-running. 

 

Download and install the Arduino Software (IDE) 

Get the latest version from the download page. You can choose between the Installer (.exe) and the Zip packages. We 

suggest you use the first one that installs directly everything you need to use the Arduino Software (IDE), including the 

drivers. With the Zip package you need to install the drivers manually. 
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When the download finishes, proceed with the installation and please allow the driver installation process. 

Choose the components to install 

Choose the installation directory (we suggest to keep the default one) 

The process will extract and install all the required files to execute properly the Arduino Software (IDE) 

 

Connect the board 

The USB connection with the PC is necessary to program the board and not just to power it up. The Uno and Mega 

automatically draw power from either the USB or an external power supply. Connect the board to your computer using 

the USB cable. The green power LED (labelled PWR) should go on. 

 

Install the board drivers 

If you used the Installer, Windows - from XP up to 10 - will install drivers automatically as soon as you connect your 

board. 

If you downloaded and expanded the Zip package or, for some reason, the board wasn't properly recognized, please 

follow the procedure below. 

Click on the Start Menu, and open up the Control Panel  

 

Click on the Start Menu, and open up the Control Panel. 

While in the Control Panel, navigate to System and Security. Next, click on System. Once the System window is up, 

open the Device Manager. 

Look under Ports (COM & LPT). You should see an open port named "Arduino UNO (COMxx)". If there is no COM 

& LPT section, look under "Other Devices" for "Unknown Device". 

Right click on the "Arduino UNO (COmxx)" port and choose the "Update Driver Software" option. 

Next, choose the "Browse my computer for Driver software" option. 

Finally, navigate to and select the driver file named "arduino.inf", located in the "Drivers" folder of the Arduino 

Software download (not the "FTDI USB Drivers" sub-directory). If you are using an old version of the IDE (1.0.3 or 

older), choose the Uno driver file named "Arduino UNO.inf" 

Windows will finish up the driver installation from there. 

 

IV. CALCULATION 

Motor selection for wheels 

Given, 

Diameter for wheels=60mm 

TORQUE REQUIRED TO RUN= 

Torque = mass * radius of wheel 

  =2*9.81*30 

  =0.2943 Nm 

       =2.94 kgcm 

Then we have to find motor of 5.88 Nm torque and rpm 30  

We are using two motors for wheels .so that total torque is divided by these two motors.\ 

So torque required for 1 motor is 2.94kgcm 

Therefore, we are selecting motor with 3 kgcm torque. 

Power output of DC motor is =voltage *current 

Power output of DC motor is =12*0.3 

Power output of DC motor is =3.6 watt 

Power=2*pi*N*0.2943/60 

3.6=2*pi*N*0.2943/60 

N=117 rpm 
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This is the maximum rpm value. 

We are selecting motor with 30rpm 

 

Code for Circuit 

// Include Libraries 

#include "Arduino.h" 

#include "BTHC05.h" 

#include "DCMDriverL293D.h" 

#include "LiquidCrystal.h" 

// Pin Definitions 

#define BTHC05_PIN_TXD 11 

#define BTHC05_PIN_RXD 10 

#define DCMOTORDRIVERA_PIN_ENABLE1 5 

#define DCMOTORDRIVERA_PIN_IN1 2 

#define DCMOTORDRIVERA_PIN_IN2 3 

#define DCMOTORDRIVERA_PIN_ENABLE2 6 

#define DCMOTORDRIVERA_PIN_IN3 4 

#define DCMOTORDRIVERA_PIN_IN4 7 

#define LCD_PIN_RS A4 

#define LCD_PIN_E A3 

#define LCD_PIN_DB4 8 

#define LCD_PIN_DB5 9 

#define LCD_PIN_DB6 12 

#define LCD_PIN_DB7 13 

// Global variables and defines 

// object initialization 

BTHC05 bthc05(BTHC05_PIN_RXD,BTHC05_PIN_TXD); 

DCMDriverL293D 

dcMotorDriverA(DCMOTORDRIVERA_PIN_ENABLE1,DCMOTORDRIVERA_PIN_IN1,DCMOTORDRIVERA_

PIN_IN2,DCMOTORDRIVERA_PIN_ENABLE2,DCMOTORDRIVERA_PIN_IN3,DCMOTORDRIVERA_PIN_IN

4); 

LiquidCrystal lcd(LCD_PIN_RS,LCD_PIN_E,LCD_PIN_DB4,LCD_PIN_DB5,LCD_PIN_DB6,LCD_PIN_DB7); 

// define vars for testing menu 

const int timeout = 10000;       //define timeout of 10 sec 

char menuOption = 0; 

long time0; 

 

// Setup the essentials for your circuit to work. It runs first every time your circuit is powered with electricity. 

void setup()  

{ 

    // Setup Serial which is useful for debugging 

    // Use the Serial Monitor to view printed messages 

    Serial.begin(9600); 

    while (!Serial) ; // wait for serial port to connect. Needed for native USB 

    Serial.println("start"); 

     

    bthc05.begin(9600); 

    //This example uses HC-05 Bluetooth to communicate with an Android device. 
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    //Download bluetooth terminal from google play store, 

https://play.google.com/store/apps/details?id=Qwerty.BluetoothTerminal&hl=en 

    //Pair and connect to 'HC-05', the default password for connection is '1234'. 

    //You should see this message from your arduino on your android device 

    bthc05.println("Bluetooth On...."); 

    // set up the LCD's number of columns and rows 

    lcd.begin(16, 2); 

    menuOption = menu(); 

    } 

// Main logic of your circuit. It defines the interaction between the components you selected. After setup, it runs over 

and over again, in an eternal loop. 

void loop()  

{ 

       

    if(menuOption == '1') { 

    // HC - 05 Bluetooth Serial Module - Test Code 

    String bthc05Str = ""; 

    //Receive String from bluetooth device 

    if (bthc05.available()) 

    { 

    //Read a complete line from bluetooth terminal 

    bthc05Str = bthc05.readStringUntil('\n'); 

    // Print raw data to serial monitor 

    Serial.print("BT Raw Data: "); 

    Serial.println(bthc05Str); 

    } 

    //Send sensor data to Bluetooth device   

    bthc05.println("PUT YOUR SENSOR DATA HERE"); 

    } 

    else if(menuOption == '2') { 

    // L293D Motor Driver with Dual Hobby DC Motors - Test Code 

    //Start both motors. note that rotation direction is determined by the motors connection to the driver. 

    //You can change the speed by setting a value between 0-255, and set the direction by changing between 1 and 0. 

    dcMotorDriverA.setMotorA(200,1); 

    dcMotorDriverA.setMotorB(200,0); 

    delay(2000); 

    //Stop both motors 

    dcMotorDriverA.stopMotors(); 

    delay(2000); 

 } 

    else if(menuOption == '3') { 

    // LCD 16x2 - Test Code 

    // Print a message to the LCD. 

    lcd.setCursor(0, 0); 

    lcd.print("Circuito Rocks !"); 

    // Turn off the display: 

    lcd.noDisplay(); 

    delay(500); 

    // Turn on the display: 
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    lcd.display(); 

    delay(500); 

    } 

      if (millis() - time0 > timeout) 

    { 

        menuOption = menu(); 

    }     

} 

// Menu function for selecting the components to be tested 

// Follow serial monitor for instrcutions 

char menu() 

{Serial.println(F("\nWhich component would you like to test?")); 

    Serial.println(F("(1) HC - 05 Bluetooth Serial Module")); 

    Serial.println(F("(2) L293D Motor Driver with Dual Hobby DC Motors")); 

    Serial.println(F("(3) LCD 16x2")); 

    Serial.println(F("(menu) send anything else or press on board reset button\n")); 

    while (!Serial.available()); 

 

    // Read data from serial monitor if received 

    while (Serial.available())  

    { 

        char c = Serial.read(); 

        if (isAlphaNumeric(c))  

        {  if(c == '1')  

       Serial.println(F("Now Testing HC - 05 Bluetooth Serial Module")); 

      else if(c == '2')  

       Serial.println(F("Now Testing L293D Motor Driver with Dual Hobby DC Motors")); 

      else if(c == '3')  

       Serial.println(F("Now Testing LCD 16x2")); 

            else 

            { 

                Serial.println(F("illegal input!")); 

                return 0; 

            } 

            time0 = millis(); 

            return c; 

        } 

    } 

} 

 

V. CONCLUSION 

Design and develop of voice command operated wheelchair is implemented. A power-assist automatic wheelchair 

prototype that effectively meets the various transportation needs of individuals with hemiplegia or physical disabilities 

will be designed, manufactured, and tested. Intricate design detail and execution resulted in a visually simplistic design 

that promotes low cost and low maintenance. The modular aspect of the components allows the system to be retrofit to 

automatic wheelchairs with only minimal modifications.  
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